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Overview
The tethaPod™, Figure 1, is designed to work with tethaPlate™ 
inserts containing tethered phospholipid bilayer membranes. 
An automated, highly optimised, multifrequency impedance 
methodology is used to accurately determine the transmembrane 
conductivity (resistance) of the bilayer. The addition of ion channel 
proteins to the membrane increases the conductivity, while the 
subsequent addition of channel blockers or activators can further 
modify the conductivity.
The use of a six–chambered tethaPlate means that sufficient 
replicates can be done in the one experiment to generate statistically 
valid results, making the system ideal for dose–response studies.

Tethered Membranes 
Within each chamber of the tethaPlate a phospholipid bilayer 
membrane is held in place above a planar gold electrode by a 
series of molecular ‘tethers’, Figure 2. These tethers comprise a 
disulphide anchor to the gold surface, a central hydrophilic PEG 
(polyethylene glycol) molecular chain, and finally a lipohilic phytanyl 
chain which embeds in the lipid bilayer. The tethers are separated 
on the gold surface by a set of shorter ‘spacer’ molecules which 
comprise only the disulphide anchor with hydrophilic PEG chain. 
The ratio of tethers to spacers is set at 1:10, which has been found 
to support a phospholipid membrane that accommodates membrane 
proteins of up to 40000 Da, Figure 3. These proteins can then form 
dimers, pentamers, etc., as required, to create the final form of the 
ion channel. Small ion channels such as gramicidin (1882 Da) and 
valinomycin (1111 Da) are equally well accommodated.

Different tether/spacer ratios can be supplied on custom orders but 
ratios of less than 1:100 are not recommended as the stability of 
the phospholipid bilayer is compromised.

Membrane Proteins
Ion channels are protein molecules, or assemblages of such 
molecules, that are housed in, or across, a phospholipid membrane. 
Simple ion channel polypeptides (such as gramicidin, valinomycin, 
magainin) are available commercially in pure form. Larger proteins 
may also be commercially available but are often supplied in a 
detergent or lipid matrix. However most such larger proteins are 
made either in–house or by a contract biotechnology company 
using bacterial culture/genomic techniques.
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tethaPod™ and tethaPlate™ 
are trademarks of SDx 

Tethered Membranes Pty Ltd, 
used under license by eDAQ.
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Figure 1
tethaPod™
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Serial Communication
The tethaPod unit sends data to the computer over a USB interface 
using a serial (RS232) protocol. Normally use the supplied tethaPod 
software to monitor the signals. Terminal emulation software (such 
as Hyperterminal, or Tera Term) can also be used, if  diagnosis is 
required for anomalous readings.

Installation
Install the software supplied on the USB memory stick with your unit. 
This will install the software and USB drivers for the tethaPod.

Connection
Connect the tethaPod unit to the USB port of a computer or, USB 
hub, Figure 1. USB ports are usually denoted with a trident–like, RS 485

Made in Australia by eDAQ Pty Ltd.

No user serviceable parts inside. 

2I  C Bus

Rated Voltage: 90 - 250 V AC   
50/60 Hz  25 VA

Refer servicing to qualified service personnel.

, icon.

tethaPlate
The tethaplate can be inserted into the socket on the top of the 
tethaPod unit by gently pushing it in. Remove by gently pulling the 
tethaPlate towards the front of the unit.
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For best results when 
recording signals:
• set your computer to 
‘never’ go to sleep. 
• turn ‘Windows 
updates’ off if you are 
using the software 
overnight.
• use the latest version 
of the tethaPod 
software.

Figure 3
Ion channel proteins 

sitting in tethered 
membranes 

(roughly to scale)
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Figure 4
Software features
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tethaPod Software 

The tethaPod software enables Windows XP, or later, computers to 
monitor signals from the six chambers in the tethaPlate inserts using 
the tethaPod hardware. Data can be copied and pasted to other 
software for further analysis or reporting, or saved in text format 
which can be read by spreadsheet or word processor software.

The software can also be used to open old data files from previous 
experiments. The names of tethaPod data files are assigned the 
extension ‘.sdx’.

Software Features
Figure 3 shows some of the basic features available when you use a 
tethaPod software.

 To start/stop collecting data click the Start/Stop button. (The 
button toggles between the two modes.)
 When started, the software will log data to a table of 
parameters (see below for a description of the various 
parameters), and
 graph membrane conductance (or resistance, see Chart menu, 
below) versus time.
 Membrane capacitance (red traces, see Chart menu) can also 
be graphed. 
 The relative proportions of screen space devoted to the graphs 
and the tabulated data can be altered by dragging the separator 
bar.
 The columns of tabulated data can be widened. 
 User annotations (for example ‘sample addition’ can be added 
in the Comments column.
 A status bar keeps track of file creation time and date, and 
hardware activity.

Parameters
The most important parameter to be determined is Rm (membrane 
resistance, in kohm), or Gm (membrane conductance, in µS). 
These two quantities are related, Gm = 1000/Rm. For an intact 
membrane, without ion channels, Rm is usually in the range 1000 – 
50000 kohm,

Note that Gm is directly proportional to the transmembrane current 
(the number of ions per second passing through the membrane) 
and is often the parameter of choice for dose/response and similar 
pharmacological studies.
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The membrane conductance, Gm is typically less than 1 µS for an 
intact phospholipid membrane, but can increase dramatically when 
an active ion channel protein is introduced, becoming as high as 
1000 µS.

The membrane capacitance,  Cm, should remain fairly constant 
(usually about 10 – 20 nF) during most experiments. Any large 
change that occurs indicates a significant disruption of the 
membrane, or its edge seals, and the values obtained for Rm and 
Gm are invalidated. 

The series capacitance, Cs, is a property of the gold electrode 
itself and not related to the membrane per se. It should remain at a 
constant value of about 100 nF. Any large change occurring during 
the experiment indicates a severe problem with the sample, and the 
values obtained for Rm and Gm are invalidated. 

The GoF parameter is quantity that defines the ‘goodness of fit’ to 
the data by a model of the membrane as a theoretical arrangement 
of a pair of capacitors and an electrical resistor, and a GoF of 
zero would be a perfect fit. A GoF value of 0.1 (or less) indicates 
excellent agreement. A threshold constituting an acceptable GoF 
can be set — see the Set GoF Threshold command in the Table 
menu, below. Data points with an unsatisfactory (large) GoF can be 
marked in green on  the various graphs, or omitted altogether.

The State parameter can have values of 1 to 4 and indicates the 
progress of a measurement cycle in each chamber of the tethaPlate. 
A data point is not finalised until State 4 is achieved. 

Parameter Value

Rm >1000 kohm

Gm <1 µS

Cm 10 – 20 nF

Cs 100 nF

Typical values for a phospholipid 
bilayer. Rm decreases (and Gm 
increases) when an ion channel is 
active.

Rm 		  Cm

Cs

Equivalent circuit used to 
analyse tethaPod signals

Figure 5
Tethered membrane 

parameters
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Menus and Other Features

File menu
The File menu has standard commands for opening new or existing 
Pod-Vu files, saving files, printing the data, and exiting the software. 
The Save As command can be used to save data as text files for 
exporting to other software. 

Edit menu
Use the Copy Selection command in the Edit menu to transfer 
selected data in the table by pasting into spreadsheet and word 
processor documents. Use the Select All command to select all the 
data in the table

The Copy Charts command enables pasting of the signal graphs 
into other documents. 

Use the Notes command to make comments and observations about 
the experiment — these annotations are saved in the data file.

Setup menu
In most cases Set Bias to zero. A non-zero bias voltage creates 
an electric field, required by some ion channel proteins to align 
themselves across the phospholipid membrane. The bias can be 
adjusted between ±500 mV before starting recording. The bias 
value is reported in the Status Bar.

If multiple tethaPod units are connected to the same computer it may 
be necessary to identify which unit is being used by using the Select 
Device command.

Table menu
This menu defines what parameters are to be displayed in the table 
area. Whatever selection is made, all parameters are always stored 
in the file and can be re-displayed or exported at a later stage. 
Data columns can be grouped by tethaPlate chamber number, or by 
similar parameter type (use the Group by Parameter command).
Set GoF Threshold defines a value above which GoF is considered 
unsatisfactory. 

Column widths can be changes by dragging the column separators 
in the column titles row, Figure 4 . The widths of the columns can 
be returned to their default values using the Reset Column Widths 
command.

8
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Chart menu
This menu controls how the Gm, Rm and Cm signals are to be 
graphed. Choose the Charts command to graph the signals, Figure 
4 , ➃. The DVM (digital voltmeter) command replaces the graphs 
with large format numerical displays. If both the Charts and DVM  
commands are unchecked then neither will be displayed and the 
tabulated results will fill the window. 
Note that you can show the graphs of Gm versus time, or Rm versus 
time, but not both simultaneously. These graphs are shown in blue. 
The graph of Cm versus time is shown in red.

The Set Scales command accesses controls to specify the Y axis 
limits for the various graphs. 

The Logarithmic Scale command uses a logarithmic Y axis for 
graphing the Gm, or Rm signals.

These signals are shown as lines joining the data points, optionally 
with Point Markers and/or with Thin Lines.

Data points with a large (unsatisfactory) GoF value (see Table 
Menu, above, to define the threshold) can be omitted from the 
graphs (Omit Bad Points), or designated with a green colored 
marker (Mark Bad Points). 

Help menu
The About command displays the tethaPod software version number, 
and computer configuration information.

The Configuration Information command gathers information about 
your computer system that can then be email to us for technical 
support.

Use the tethaPod Manual command to access a pdf file of this 
manual.

Start/Stop button
The Start/Stop command starts and halts data collection, Figure 4 
.

Status bar 
The Status bar, Figure 4 ➇, shows the virtual COM port that the 
tethaPod is using, whether or not the software is collecting data, 
bias voltage, and the date and time at which data collection 
began.

Status bar
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Specifications

tethaPod
Channels:	 6

Communication:	 USB virtual serial port (VSP)

VSP driver:	 http://www.ftdichip.com/Drivers/VCP.htm

COM port settings:	 9600 baud; 8 bits; 1 stopbit; no parity; flow NONE

AC frequencies: 	 0.125, 0.25, 0.5, 1.25, 2.5, 5.0, 12.5, 25, 50, 	
	 1000 Hz

AC amplitude:	 ±10 mV (20 mV p-p)

DC bias voltage:	 ±0.5 V maximum

Membrane resistance:	 10 – 5000 kohm (0.2 – 100 µS)

Dimensions (h x w x d):	 50 x 129 x 168 mm

Weight: 	 ~470 g

Operating conditions:	 0 — 40 °C, 0 — 90% humidity (non condensing)

tethaPlate
Cartridge body: 	 white polycarbonate, 75 x 39 x 7 mm

Chambers:	 6

Gold electrode substrate:	 transparent polycarbonate slide, 75 x 25 x 1 mm

Tethered electrode dimensions:	3.0 x 0.7 mm (area 0.21 mm2)

Flow channel depth:	 0.15 mm

Loading port:	 4.5 mm diameter circle, 4.5 mm deep

Waste port:	 22 x 7.5 mm, 4.5 mm deep

Tethers: 	 benzyl-disulphide-bis-tetraethyleneglycolmonophytane

Spacers:	 benzyl-disulphide-bis-tetraethyleneglycol

Weight: 	 ~11 g

Phospholipid Mix
Volume: 	 1 mL 

Total lipid concentration:	 3 mM in ethanol

Lipid mixture:	 diphytanyletherphosphatidylcholine 70% and		
	 glycerodiphytanylether 30%

10
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Inserting Ion Channels
To add solutions to a tethaPlate simply pipette a small volume to 
the input port of a chamber (Figure 1). The solution will then pass 
through the chamber, and across the tethered membrane coated 
electrode. Excess solution will appear at the waste port and can 
be removed by pipette if desired. Take care to avoid the introduc-
tion of air bubbles into the chamber.

There are several common protocols used for incorporation of ion 
channels into a tethered membrane:

1. Spontaneous insertion into a preformed tethered membrane. 
This is has been used for CLIC (the protein chloride intracellular 
ion channel), or the bacterial ion channel alpha–hemolysin. The 
ion channel is added in a solution of PBS (physiological buffer 
solution). Cholesterol and/or the presence of charged lipids 
(such as phosphatidylethanolamine) can sometimes accelerate 
incorporation, as can lower pH (down to pH 4.5 or so).

A variant of this approach is to use detergent (for example 
Tween20®) assisted insertion which has been used for the 
mechanosensitive channel MscL. After insertion fresh PBS is 
used to rinse the chamber, removing the excess ion channel and 
other reagents. It is also possible for fusion of an ion channel–
containing proteoliposome to take place with a preformed 
tethered membrane

2. The second major approach is to form the tethered membrane  
in the presence of the ion channel (with or without a detergent). 
For example a liposomal suspension of voltage dependent anion 
channel (VDAC) can be added to the chamber of a tethaPlate so 
that the lipids comprising the liposomes form a bilayer while the 
ion channel is simultaneously incorporated into the membrane. 
Bacterial sodium channel (NaChBac), incorporates at time of 
membrane formation with Cymal-5 detergent. Small conductance 
mechanosensitive channel (MscL) requires charged lipids (such 
as phosphatidylethanolamine) to accelerate insertion and can 
be incorporated at time of membrane formation from DDM 
detergent.

Once inserted, by whatever means, protein ion channels usually 
exhibit good stability in tethered membranes, and can often be 
used for long periods (several days or more) provided that the 
tethaPlate is stored below 4°C when not in use.
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TradeMarks
tethaPod, tethaPlate and tethaPlasm are trademarks of SDx Tethered Membranes Pty Ltd 
and used by eDAQ under license. 

Warranty
eDAQ Pty Ltd warrants tethaPod systems, to be free of defects in material and workmanship 
for one year from the date of purchase. eDAQ Pty Ltd will repair or replace defective 
equipment as appropriate.

To obtain a warranty repair/replacement you must first notify us before return of the 
instrument and we will issue you with a RAN (return authorization number). You must ship 
the defective product at your expense. We will pay return shipping. The product should 
be packed safely (preferably in its original packaging) and have the RAN on the shipping 
label. Returns sent without a RAN may be refused delivery.

This warranty does not cover hardware that has:
• been modified by the user in any way;
• been subjected to unusual physical, electrical, or environmental stress. This includes 
damage due to faulty power sockets, inadequate earthing, or power spikes or surges;
• been damaged because of incorrect wiring to ancillary equipment, or because of 
substandard, connectors or cables; or
• had the original identification marks removed or altered. 

Software License
You have the non-exclusive right to use the supplied tethaPod software. (Your employees 
or students, for example, are entitled to use it, provided they adhere to this agreement.) 
Each separate purchase of the tethaPod software licenses it to be used on two computers 
at any given time (on one computer for data acquisition with tethaPod hardware units, and 
on a second computer for the review and analysis of existing data files). Although multiple 
copies of a program may exist on several computers, more than two copies must not be 
used simultaneously. Departmental/company licences are available if you wish to run more 
than two copies simultaneously.

Jurisdiction
eDAQ Pty Ltd is bound by the laws of New South Wales in Australia, and any proceed-
ings shall be heard by the Supreme Court of New South Wales in Australia.

Technical Support
Technical assistance is available via email. Ensure that you are using the latest version of 
the tethaPod software, which can be downloaded at http://www.edaq.com/support.php 
Please describe the problem with as much detail as possible. Include an example data file, 
if appropriate. Please also state:

• the serial numbers of your tethaPod units; and
• information gathered with the Configuration Information command in the Help menu.

We endeavor to answer all your questions, but in some cases, for example where the 
problem relates to the other equipment that you are using, a nominal fee may be charged.

Disclaimer
1. eDAQ Pty Ltd reserves the right to alter specifications of hardware and software without 
notice. 

2. No liability can be accepted for consequential damages resulting from use of eDAQ 
products.

Document Number: U–ES350–0112

Copyright © January 2012

All rights reserved. No part of this document 
may be reproduced by any means without the 
prior written permission of eDAQ Pty Ltd. 

eDAQ Pty Ltd
6 Doig Avenue

Denistone East, NSW 2121
Australia

www.edaq.com
E-mail: info@edaq.com
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